Table of Contents

Chapter 1  Overview ................................................................................................................ 5

Chapter 2  About WebEx Recorder and Player ................................................................. 7
  About the WebEx Network-Based Recorder and Network Recording Player (for ARF files). 7
  About the WebEx Recorder and Player (for WRF files) ....................................................... 8
  About the standalone recorder ............................................................................................... 8
  System requirements for WebEx Recorder and Player (for WRF files) ............................... 8

Chapter 3  Using the recorder .......................................................................................... 11

Chapter 4  Using the standalone recorder ................................................................. 15
  Recording an application or your desktop ......................................................................... 15
  Switching to another application during recording .......................................................... 18
  Recording multiple applications simultaneously ............................................................... 18

Chapter 5  Hiding the Recorder Panel during recording .............................................. 19

Chapter 6  Recording annotations ..................................................................................... 23
  Making annotations while recording a meeting ............................................................... 23
  Making annotations using the standalone recorder .......................................................... 23
Chapter 7  Inserting markers into a recording ................................................................. 25

Chapter 8  Recording audio with standalone recorders .................................................. 29

  System requirements for recording audio ........................................................................ 29

    General system requirements .......................................................................................... 30

    Input devices for recording a teleconference .............................................................. 30

    Input devices for recording an Integrated VoIP conference ........................................... 31

    Input devices for recording only your voice ............................................................... 31

    Input devices for recording audio in files .................................................................... 32

    Setting up your sound card for recording audio ............................................................ 32

    Turning audio recording on or off ................................................................................. 35

    Adjusting audio input volume during recording ........................................................... 36

    File size estimates for recordings .................................................................................. 36

Chapter 9  Making quality recordings ........................................................................... 39

  Improving video quality .................................................................................................. 39

  Improving audio quality .................................................................................................. 40

  Editing a recording .......................................................................................................... 41

Chapter 10  Distributing your recordings ...................................................................... 43

Chapter 11  Using WebEx Player .................................................................................. 45

  Installing WebEx Player .................................................................................................. 45

  System requirements for listening to audio in a recording ............................................ 45

  Playing a recording .......................................................................................................... 45
Overview

This guide provides instructions for using WebEx Recorder and WebEx Player. This guide assumes that you have a user account on your WebEx service.

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Get an overview about the WebEx Recorder and Player</td>
<td>About WebEx Recorder and Player (on page 7)</td>
</tr>
<tr>
<td>Use the recorder</td>
<td>Using the recorder (on page 11)</td>
</tr>
<tr>
<td>Use the standalone recorder</td>
<td>Using the standalone recorder (on page 15)</td>
</tr>
<tr>
<td>Hide the Recorder Panel during recording</td>
<td>Hiding the Recorder Panel during recording (on page 19)</td>
</tr>
<tr>
<td>Record annotations</td>
<td>Recording annotations (on page 23)</td>
</tr>
<tr>
<td>Insert markers into a recording</td>
<td>Inserting markers into a recording (on page 25)</td>
</tr>
<tr>
<td>Record audio</td>
<td>Recording audio with standalone recorders (on page 29)</td>
</tr>
<tr>
<td>Estimate file size</td>
<td>File size estimates for recordings (on page 36)</td>
</tr>
<tr>
<td>Make quality recordings</td>
<td>Making quality recordings (on page 39)</td>
</tr>
<tr>
<td>Distribute recordings</td>
<td>Distributing your recordings (on page 43)</td>
</tr>
<tr>
<td>Use the WebEx player</td>
<td>Using WebEx Player (on page 45)</td>
</tr>
<tr>
<td>Troubleshoot playback errors.</td>
<td>Troubleshooting playback (on page 55)</td>
</tr>
</tbody>
</table>
About WebEx Recorder and Player

Use the WebEx Recorder to create a video recording of all screen activity on your computer, including mouse movements and annotations. You can also capture synchronized audio in your recording.

WebEx recorders and players are available in these versions:

- WebEx Network-Based Recorder (NBR) and WebEx Network Recording Player (for ARF files)
- WebEx Recorder and Player (for WRF files)
- WebEx Recording Editor

About the WebEx Network-Based Recorder and Network Recording Player (for ARF files)

The Network-Based Recorder is available during an online meeting. This recorder captures screen activity and audio on a WebEx recording server, thereby saving processor resources and hard disk space on your computer. The server automatically processes your recorded data, and then sends the recording file to your My Recordings page on your WebEx service site.

Use the Network-Based Recorder to easily capture all audio in your meeting's teleconference, without having to use a phone recording adapter (a device that connects your phone to your computer’s sound card). However, if you want to capture audio in an Integrated VoIP conference, use the integrated meeting recorder instead.
Chapter 2: About WebEx Recorder and Player

About the WebEx Recorder and Player (for WRF files)

The integrated meeting recorder is available during an online meeting. This recorder captures screen activity and audio in a meeting or on your desktop, and then saves the recorded data in a recording file on your local computer.

Use the integrated recorder to capture all audio that plays "through" your computer, such as an Integrated VoIP conference or sound that media files play. You can also capture audio in a traditional teleconference using a phone recording adapter, which connects your phone to your computer.

About the standalone recorder

The standalone recorder is available only offline—that is, outside of an online meeting. This recorder lets you record all screen activity in any application on your computer, and then saves it in a recording file on your computer.

Use the standalone recorder to create software demonstrations, tutorials, sales presentations, and so on. To capture audio in an application recording, simply connect a microphone to your computer.

You can download the standalone recorder from your WebEx service site.

System requirements for WebEx Recorder and Player (for WRF files)

Note: This guide assumes that you have a valid user account on your WebEx site.

To effectively use the WebEx Recorder and Player, make sure that your computer meets the following system requirements:

- Refer to the WebEx cross-platform release notes for supported operating systems, browsers, and other minimum system requirements for Windows and Mac OS X (Mac OS X is supported only for the WebEx Player).
- (For recording) a sound card and a microphone or telephone recording adapter
- (For playback) a sound card and speakers or and headphones

Note: Additional equipment is required for recording audio with the integrated and standalone recorders. For details, see System requirements for recording audio (on page 29).
Using the recorder

Once you start recording an online meeting, the integrated recorder begins saving the recording to a file on your computer. Ensure that you have enough space on your hard disk for a recording. For information about file size estimates for recordings, see *File size estimates for recordings* (on page 36).

**Note:** When scheduling your meeting, set up the teleconference that you want to record during the session:

When using a third-party teleconferencing service, you will need to use your service’s "dial-out” feature during the meeting to connect the teleconference to the recording server. Before starting your meeting, have the dial-out instructions handy.

To capture audio in a recorded meeting, set up your computer’s sound card and attach the appropriate audio input device. For more information, see *Recording audio with standalone recorders* (on page 29).

**To start recording an online meeting:**

1. On the Meeting menu, choose Recorder Settings > Record on This Computer.

2. Ensure that Record on This Computer is selected.

3. Do one of the following:
Chapter 3: Using the recorder

- On the Meeting, Event, or Session menu, choose Start Recording.

- On the CSR dashboard, click the Session tab, and then click Record Session.

You can open the WebEx Recorder only after a customer joins the session. The customer must then grant permission for you to record the session.

4 In the Save Recorded Meeting As dialog box, choose a location at which to save the recording, specify a file name, and then click Save.

The Recorder Panel appears.

5 On the Recorder Panel, click the Record button.

The Progress and File Size indicator on the Recorder Panel indicates the current duration of the recording, in hours, minutes, and seconds; and the current file size of the recording file, in kilobytes.
Chapter 3: Using the recorder

To pause and then resume recording:

On the Recorder Panel, click the Pause button.

Then, to resume recording, click the Pause button again.

To stop recording:

On the Recorder Panel, click the Stop button.

WebEx Recorder saves your recording to a file in the WebEx Recording Format (WRF), which has a .wrf extension.
Chapter 3: Using the recorder

Note:

- While recording, you can:
  - Hide the Recorder Panel so it does not appear in your recording. For details, see *Hiding the Recorder Panel during recording* (on page 19).
  - Use annotation tools to highlight areas on your screen. For details, see *Recording annotations* (on page 23).
  - Set markers, so you can quickly locate a position in a recorder later. For details, see *Inserting markers into a recording* (on page 25).

- By default, only the host and the presenter can record an online meeting using the integrated meeting recorder. Attendees can record an online meeting only if a presenter grants recording privileges to them.
Using the standalone recorder

You can use the standalone recorder to perform the following tasks:

- record an application on your desktop
- switch to another application during recording
- record multiple applications

Recording an application or your desktop

Once you start recording an application or your desktop, the standalone recorder begins saving the recording to a file on your computer. Ensure that you have enough space on your hard disk for a recording. For information about file size estimates for recordings, see File size estimates for recordings (on page 36).

To capture audio in a recorded application or desktop, you must set up your computer’s sound card and attach the appropriate audio input device. For more information, see Recording audio with standalone recorders (on page 29).

To start WebEx Recorder:

Do either of the following on your computer’s desktop:

- Click Start, point to Programs, point to WebEx Recorder & Player, and then click WebEx Recorder.
- Double-click the WebEx Recorder shortcut on your computer’s desktop.

The WebEx Recorder console appears.
Chapter 4: Using the standalone recorder

To start recording:

1. On the WebEx Recorder console, click the Open Application button.

2. In the WebEx Recorder - Open Application dialog box, select an application or your desktop.

3. Click Select.

4. Choose a location at which to save the recording.

5. In the File name box, type a name for the file, and then click Save.

6. On the Recorder Panel, click the Record button.
To pause and then resume recording:
On the Recorder Panel, click Pause.

Then, to resume recording, click the Pause button again.

To stop recording:
On the Recorder Panel, click Stop.

WebEx Recorder saves your recording to a file in the WebEx Recording Format (WRF), which has a .wrf extension.

To exit WebEx Recorder:
On the File menu, choose Exit.

Note: While recording, you can:
- Record another application without stopping WebEx Recorder first. For details, see Switching to another application during recording (on page 18)
- Record multiple applications at the same time. For details, see Recording multiple applications simultaneously (on page 18).
- Hide the Recorder Panel so it does not appear in your recording. For details, see Hiding the Recorder Panel during recording (on page 19).
- Use annotation tools to highlight areas on your screen. For details, see Recording annotations (on page 23).
- Set markers, so you can quickly locate a position in a recorder later. For details, see Inserting markers into a recording (on page 25).
Switching to another application during recording

Once you start recording an application using the standalone recorder, you can switch to recording another application, without stopping WebEx Recorder. Thus, you can create a single recording that captures your actions with two or more applications in a sequence.

1. Pause recording.
   The WebEx Recorder button appears on your computer's taskbar.

2. Click WebEx Recorder.

3. In the list, select the application that you are currently recording to highlight it.

4. Click Unselect.

5. In the list, select another application to record.

6. Click Select.

7. Resume recording.

Recording multiple applications simultaneously

Once you start recording a single application, you can start recording another application simultaneously, without stopping WebEx Recorder.

To record multiple applications simultaneously:

1. Pause recording.
   The WebEx Recorder button appears on your computer’s taskbar.

2. Click WebEx Recorder.

3. In the list, select another application that you want to record.

4. Click Select.

5. Resume recording.
Hiding the Recorder Panel during recording

For the standalone recorder only

Normally, the Recorder Panel appears on your screen during recording, and thus will appear in the recording. However, before you begin recording, you can hide the Recorder Panel. If the Recorder Panel is hidden, you can pause or stop recording by pressing a *hot key*—that is, a key or combination of keys on your computer’s keyboard.

To hide the Recorder Panel:

1. On the Recorder Console of the standalone recorder, on the *Settings* menu, choose WebEx Recorder Settings.

2. Do either of the following:
   - If you are using the integrated recorder, on Meeting menu in the Meeting Window, choose Recorder Settings > Recorder Panel.
     
     The WebEx Recorder Settings dialog box appears.
- If you are using the standalone recorder, on the Recorder Console, on the Settings menu, choose WebEx Recorder Settings.
3 On the Recorder Panel tab, or under Recorder Panel Settings, select the Hide the Recorder panel during recording check box.

Default hot keys appear in the Pause/Resume and Stop boxes. While recording, you can press the appropriate hot key to stop or pause recording.

4 Optional. To specify your own hot keys, click in the Pause/Resume or Stop boxes, and then do one of the following:

- Type a different character.
- Hold down the Control or Shift key, and then press another key.
- Hold down both the Control and Shift keys, and then press another key.

5 Click Ok.

To show the Recorder Panel after it is hidden:

During recording, press the hot keys that you specified to either pause or stop recording.

The default hot keys are the following:

- Pause recording: Ctrl+Alt+P key combination
- Stop recording: Ctrl+Alt+S key combination
Recording annotations

While recording, you can use the highlighter tool to make annotations. Your annotations appear in the recording during playback.

Making annotations while recording a meeting

When using the Network-Based Recorder or the integrated recorder to record an online meeting, you can use the annotation tools available in the meeting. For example, if you are sharing an application, any annotations you or other participants make using the annotation tools on the Tools panel will appear in your recording. For more information about using annotation tools, refer to the online Help for your service center.

Making annotations using the standalone recorder

To make annotations using the standalone recorder:

Do any one of the following:

- On the Recorder panel, click Annotate.
In the lower-right corner of your computer’s taskbar, click the Recording button.

Then, on the menu that appears, choose **Annotate**.

In the title bar of the application that you are recording, click **Recording**.

Then, on the menu that appears, choose **Annotate**.

Your mouse pointer changes to a highlighter so you can make annotations.

**To change your annotation color:**

1. Right-click the highlighter mouse pointer.
2. On the menu that appears, choose **Annotation Colors**.
3. On the color palette that appears, select a different color.

**To exit annotation mode:**

1. Right-click the highlighter mouse pointer.
2. On the menu that appears, choose **Stop Annotating**.
Inserting markers into a recording

During recording, you can insert one or more markers into the recording. A marker is a placeholder that lets you quickly locate a position in a recording file when editing it using WebEx Recording Editor. For more information about WebEx Recording Editor, see Editing a recording (on page 41).

For example, if you are recording an online meeting and someone makes an important comment, you can quickly insert a marker into the recording at that time. Then, when editing the recording, you can quickly locate the point in the recording at which the comment was made.

You can insert a marker using either the Recorder Panel or a hot key—that is, a key or combination of keys on your computer’s keyboard. A hot key is useful if you set up the Recorder Panel to be hidden during recorder.

To insert a marker into a recording using the Recorder Panel:

On the Recorder Panel, click the Insert Marker button.
To insert a marker into a recording using a hot key:

1. On the Recorder console of the standalone recorder, on the Settings menu, choose WebEx Recorder Settings.

2. Do either of the following:
   - If you are using the integrated recorder, on Meeting menu in the Meeting window, choose Recorder Settings > Recorder Panel.
     
     The WebEx Recorder Settings dialog box appears. On the Recorder Markers tab, a default hot key appears in the box. While recording, you can press this hot key to insert a marker.

   - If you are using the standalone recorder, on the Recorder Console, on the Settings menu, choose WebEx Recorder Settings.
     
     The WebEx Recorder Settings dialog box appears. Under Recorder Markers Settings, a default hot key appears in the box. While recording, you can press this hot key to insert a marker.
3 Optional. To specify your own hot key, click in the box, and then do _one_ of the following:
   - Hold down the **Control** or **Shift** key, and then press another key.
   - Hold down both the **Control** and **Shift** keys, and then press another key.

4 Click **OK**.
Recording audio with standalone recorders

If you are using either the integrated meeting recorder or the standalone recorder, you can optionally record audio from the following sources, depending on the type of audio input device you use:

- A teleconference, if you are participating in an online meeting
- Integrated VoIP conference, if you are participating in an online meeting
- Rich media files, such as audio and video files

WebEx Recorder automatically synchronizes audio with your sequence of actions in an application or meeting.

**Note:** If you use the Network-Based Recorder, the recording server can automatically capture audio in a teleconference. You do not need to connect an additional audio input device. For details, see [Using the recorder](on page 11).

**System requirements for recording audio**

System requirements for recording audio include the following:

- For general system requirement information, see [General system requirements](on page 30).
- For information on required input devices, see the following topics:
  - [Input devices for recording a teleconference](on page 30)
  - [Input devices for recording an Integrated VoIP conference](on page 31)
  - [Input devices for recording only your voice](on page 31)
Chapter 8: Recording audio with standalone recorders

- **Input devices for recording audio in files** (on page 32)

General system requirements

To record audio using the integrated meeting recorder or the standalone recorder, ensure that your computer meets the following system requirements:

- Intel Pentium III 667 MHz or faster
- 128 MB RAM or more
- Creative Labs Sound Blaster or equivalent sound card

For a list of recommended sound cards, refer to the Recording and Playback Frequently Asked Questions (FAQ) page on your Meeting Center Web site.

- Input device for capturing audio

  Use an input device that is appropriate for the type of audio that you want to capture.

Input devices for recording a teleconference

To record a teleconference for an online meeting, you must connect the recording computer to a telephone using one of the following:

- **Phone recording adapter**—Connects your phone to your computer’s sound card.

  A phone recording adapter captures all audio in a teleconference. The following two phone recording adapters from DynaMetric, Inc. are compatible with WebEx Recorder: TLP-102 Telephone Logger Patch and TMP-636 Transmit and Receive Patch. To connect a phone recording adapter to your computer’s sound card, follow the instructions that DynaMetric provides.

  To record audio in rich media files, such as audio and video files, you must use a phone recording adapter that supports bidirectional audio between your phone and computer—that is, connects to both the input and output jacks for your computer’s sound card. The DynaMetric TMP-636 adapter supports bidirectional audio.

  To purchase a DynaMetric phone recording adapter, please visit the following Web address:

  www.dynametric.com
  www.dynametric.com/webex_purchasing.html

- **Universal multimedia amplifier**—Connects your telephone to a headset and your computer’s sound card.
You can use a universal multimedia amplifier as a phone recording adapter to capture all audio in a teleconference. Using a universal multimedia amplifier is ideal if you often speak in teleconferences, Integrated VoIP conferences, and standalone recording sessions, because it allows you to switch between a phone headset and a computer headset. The following universal amplifier is known to be compatible with WebEx Recorder: Plantronics MX10 Universal Amplifier.

To record audio in shared files, such as UCF rich media files, you must use a universal multimedia amplifier that supports bidirectional audio between your phone and computer—that is, connects to both the input and output jacks for your computer’s sound card. The Plantronics MX10 Universal Amplifier supports bidirectional audio.

To purchase a Plantronics universal multimedia amplifier, please visit the following Web address:

www.plantronics.com

- **Conference phone with RCA output jack**
  
  To capture audio using a conference phone or speakerphone, connect the phone’s RCA audio output jack to the microphone input jack on your computer’s sound card.

  **Note:** For better audio quality and convenience, use a phone headset when recording a teleconference.

### Input devices for recording an Integrated VoIP conference

To record audio in an Integrated VoIP conference during an online meeting, you can use either of the following audio input devices:

- **Microphone:** Connects to the audio input line for your computer’s sound card.
- **Computer headset:** Connects to the audio input line for your computer’s sound card and includes a microphone and earphones.

  **Tip:** If you often switch between using a traditional teleconference and Integrated VoIP for your online meetings, use a universal multimedia amplifier.

### Input devices for recording only your voice

To record only your voice—for example, when recording a software demonstration—you can use any of the audio input devices for a teleconference or Integrated VoIP conference.
Input devices for recording audio in files

To record audio in rich media files—such as audio and video files—you must connect one of the following audio input devices to your recording computer.

- Phone recording adapter
- Universal multimedia amplifier

Setting up your sound card for recording audio

Before you start recording audio using the integrated meeting recorder or the standalone recorder, do the following to set up your computer’s sound card:

- Select sound card: Select the sound card that you want to use for recording and playing sound, if your computer has multiple sound cards.
- Adjust audio volume
  - Adjust the audio input volume for your microphone or phone, which determines the sensitivity of WebEx Recorder when capturing audio.
  - Adjust the audio output volume for your speakers or earphones.
- Specify microphone settings
  - For recording, ensure that the microphone input setting is either selected or not muted, depending on your sound card, and that all other input controls are either muted or not selected.
  - For playback, ensure that the microphone input setting is either not selected or muted, depending on your sound card.
- You can set up your computer’s sound card in either of two ways:
  - Use the Audio Setup Wizard, which is available in the standalone WebEx Recorder only. The wizard automatically specifies the correct recording and playback settings for your microphone.
  - Use your sound card’s volume controls and Windows Sound Recorder to manually set up your sound card.

To sound card:setting up with Audio Setup Wizard;Audio Setup Wizard;use the Audio Setup Wizard to set up your sound card:

1. On the WebEx Recorder console, on the Settings menu, choose Audio Setup Wizard.
2 Follow the instructions in the wizard.

**Tip:** When adjusting the microphone level (audio input volume), speak into the audio input device that you want to use when making the actual recording. For example, if you want to use a phone recording adapter to record audio in a teleconference, connect the adapter, make a phone call, then speak into your phone or headset microphone while adjusting the microphone level.

**To set up your sound card manually:**

1 Open your sound card's volume controls as follows:
   a) On your computer's desktop, click Start.
   b) Point to Programs, point to Accessories, and then point to Entertainment.
   c) Choose Volume Control.
2 On the Options menu, choose Properties.

3 Optional. If your computer has more than one sound card, in the Mixer device list, select the sound card that you want to use for recording.

4 Select Playback, and then click OK.

5 In the Volume Controls dialog box, ensure that the Microphone setting is either muted or not selected, depending on your sound card.

6 On the Options menu, choose Properties again.

7 Select Recording, and then click OK.

8 In the Recording Control dialog box, ensure that the Microphone setting is either selected or not muted, depending on your sound card.

   Leave Recording Control dialog box open on your screen.

9 Start Windows Sound Recorder, as follows:

   a) On your computer’s desktop, click Start.

   b) Point to Programs, point to Accessories, and then point to Entertainment.

   c) Choose Sound Recorder.

10 Use Sound Recorder to record your voice as you speak into the audio input device that you want to use when making the actual recording.
While speaking, adjust the Microphone volume as necessary, using the Volume slider in the Recording Control dialog box.

Play back your recording.

If the audio is too low, increase the Microphone volume. If the audio is distorted, decrease the Microphone volume.

If necessary, continue recording your voice and adjusting the Microphone volume. Use your sound card's volume controls and Windows Sound Recorder to manually set up your sound card.

Turning audio recording on or off

By default, the integrated and standalone versions of WebEx Recorder are set to record audio from your computer's sound card. However, you can turn audio recording on or off.

To turn audio recording on or off during recording:

On the Recorder Panel, select or clear the Record PC Audio check box to turn audio recording on or off, respectively.
Adjusting audio input volume during recording

While recording an application or meeting, you can adjust the audio input volume for your microphone, which determines the sensitivity of WebEx Recorder when capturing audio.

To adjust audio input volume while recording:

While speaking into your microphone, use the Microphone Volume slider to adjust your microphone level.

Ensure that the microphone level remains below the topmost level of the Microphone Volume indicator.

Tip: It is recommended that you adjust the audio input volume for your microphone before you begin recording, and adjust the volume during recording only to make minor adjustments, if necessary. For details about adjusting the audio input volume before recording, see Setting up your sound card for recording audio.

File size estimates for recordings

Without audio, WebEx Recorder captures approximately 10 MB of video data per hour of recording. However, when recording frequent actions in an application or meeting, WebEx Recorder may capture significantly more data.

When recording audio, the amount of recorded data that WebEx Recorder captures depends largely on the audio compression scheme and sampling rate that you select. The following are estimates of the data that WebEx Recorder captures for the available audio sampling rates.
### Chapter 8: Recording audio with standalone recorders

If you set WebEx Recorder to this audio compression scheme and sampling rate...

<table>
<thead>
<tr>
<th>Compression Scheme</th>
<th>Recorded Data Per Hour</th>
</tr>
</thead>
<tbody>
<tr>
<td>G.723 at 8 KHz</td>
<td>15 MB</td>
</tr>
<tr>
<td>PCM at 8 KHz</td>
<td>70 MB</td>
</tr>
<tr>
<td>PCM at 22 KHz</td>
<td>170 MB</td>
</tr>
<tr>
<td>PCM at 44 KHz</td>
<td>325 MB</td>
</tr>
</tbody>
</table>

**Note:** If you use the Network-Based Recorder, you cannot set the audio compression scheme or the audio sampling rate. The Network-Based Recorder always captures audio using the G.723 compression scheme at a rate of 8 KHz. However, this setting usually provides good quality audio for most purposes.
Making quality recordings

WebEx Recorder captures video at a rate of 2.5 frames per second, which creates high-quality recordings while keeping file sizes relatively small. However, the quality of a recording also depends on several factors that you can control. See the following sections for tips on how to improve the quality of your recordings:

- For tips on improving video quality, see *Improving video quality* (on page 39).
- For tips on improving audio quality, see *Improving audio quality* (on page 40).
- For tips on editing a recording, see *Editing a recording* (on page 41).

### Improving video quality

- WebEx Recorder may not completely capture sudden, rapid mouse movements. Therefore, during recording, move your mouse slowly at first, and then gradually increase the speed of your mouse movements.

- Before clicking a button, menu, or other object, pause your mouse pointer briefly over the object. Doing so ensures that WebEx Recorder captures the mouse pointer before you click the object.

- If you will include complex or lengthy actions in a recording, consider writing down the sequences that you plan to take before you start recording.

- If you are using the integrated meeting recorder or the standalone recorder, and you plan to distribute your recording to the public or to a large or diverse audience, set your monitor’s display resolution to 800 by 600 pixels before recording. Recording images at higher resolutions may cause recorded images to be partially hidden during playback on computers with monitors set to lower resolutions.

- If you are using the Network-Based Recorder, set your monitor's display resolution to 1024 by 768 pixels before recording.
Improving audio quality

- The quality of the audio that you hear during playback depends greatly on the quality of your computer's equipment—that is, its sound card, microphone, and speakers. If the audio in your recordings is consistently of poor quality or sounds "tinny," consider upgrading your equipment.

- To avoid mistakes during recording, script your audio before you begin recording.

- Ensure that the audio input volume for your microphone is set to an appropriate level. You can usually achieve the best playback fidelity if you set the input volume to the highest level without causing distortion. To set the optimal input volume, you can use the Audio Setup Wizard for WebEx Recorder or your sound card's volume controls. For more information, see Setting up your sound card for recording audio. (Not applicable to the Network-Based Recorder.)

- When recording audio in a teleconference, use a phone headset. This device typically provides better audio quality than a phone handset or speakerphone. For more information, see System requirements for recording audio (on page 29).

- When recording audio in an Integrated VoIP conference, use a computer headset. This device can provide better audio quality than a standard microphone. For more information, see System requirements for recording audio (on page 29). (Not applicable to the Network-Based Recorder.)

- If you are using a microphone to capture audio, speak into your microphone at an appropriate distance. Typically, WebEx Recorder captures clear, full tones if you are about 6 inches away from the microphone. However, you may want to experiment with various distances to determine the ideal distance for you. (Not applicable to the Network-Based Recorder.)

- Choose an appropriate audio sampling rate for the type of recording that you want to make. You can experiment with various sampling rates before recording an application or meeting. For more information about choosing an audio sampling rate, see Table , Specifying audio quality for recording, on page 24. (Not applicable to the Network-Based Recorder.)

- To avoid unwanted background noise in a recording, make the recording at a quiet location. During recording, avoid moving objects that create noise, such as papers, books, writing instruments, and so on.

- When speaking into a microphone, you may need to exaggerate your enunciation of words slightly to ensure that they are clear during playback.
Editing a recording

If your Meeting Center Web site includes the WebEx Recording Editor option, you can use WebEx Recording Editor to remove unwanted data—such as long pauses, mistakes, and so on—before you distribute the recording. You can also use WebEx Recording Editor to add recorded data from another recording, rearrange recorded data, or dub audio. Moreover, WebEx Recording Editor lets you define segments in a recording—much like tracks on a CD—to which users can navigate during playback in WebEx Player.

For more information about WebEx Recording Editor refer to the WebEx Recording Editor User’s Guide on your Meeting Center Web site.

If your Training Center service includes the Presentation Studio Integration option, you can also edit a recording using the Presentation Studio Editor. Using this editor, you can add slides, insert tests, or provide additional narration to your recording. For details, refer to the online Help for Training Center.
Distributing your recordings

Once you complete a recording, and edit it as necessary, you can:

- Publish your recording on your WebEx service Web site or in the My Files section of My WebEx. For details, refer to the online help.

- Have your company's Webmaster publish your recording on your organization's Web site. Once a visitor to your site clicks a link for a recording, a playback server automatically downloads WebEx Player to the visitor's computer, if necessary, then streams the recording to the visitor's computer. By streaming recordings, you allow visitors to play recordings without the need to download them onto their computers.

For more information about publishing a recording for playback over the Internet, refer to the guide *Streaming Recordings on Your Web Site*. This guide is available on the Recording and Playback FAQ on your WebEx service Web site.

- Provide your recording file directly to the people whom you want to view it. If they do not have WebEx Player, you can download the WebEx Player installation program from the Recording and Playback page on your Meeting Center Web site, and then provide them with the program.
Using WebEx Player

Using WebEx Player, you can play back any recording that was made using WebEx Recorder—that is, a WebEx Recording Format (.wrf) file.

Installing WebEx Player

If you do not yet have WebEx Player, or want to download the WebEx Player installer for users to whom you want to provide a recording, you can download it from the Recording and Playback page on your WebEx Web site.

System requirements for listening to audio in a recording

You can listen to audio in a WebEx Recording Format (.wrf) file, if your computer has the following:

- A Creative Labs Sound Blaster or equivalent sound card
- Speakers, or headphone jack and headphones

Playing a recording

You can play a recording that resides on your computer or that is published on a Web site.

To start WebEx Player:

Do either of the following on your computer’s desktop:

- Select the WebEx Player shortcut on your computer’s desktop.
Chapter 11: Using WebEx Player

- *(Windows only)* Select Start > Programs > WebEx Recorder & Player > WebEx Player.

The WebEx Player console appears.

### Windows

![WebEx Player](image)

### Mac

![WebEx Player](image)

To play a recording that resides on your computer:

Do either of the following:

- Double-click a recording file.
  
  WebEx Player starts and plays the recording automatically.

- On the WebEx Player console, click the **Open** button, and then select a recording.
  
  Then, on the WebEx Player console, click the **Play** button.
Chapter 11: Using WebEx Player

To play a recording that is published on a Web site:
Go to the Web page on which the recording is published, and then click the link for the recording. WebEx Player plays the recording automatically.

To pause and then resume playback:
To pause playback, on the WebEx Player console, click the Pause button.

Then, to resume playback, on the WebEx Player console, click the Pause button again.

To automatically repeat (loop) playback:
On the WebEx Player console, on the Controls menu, choose Loop.

To stop a playback:
On the WebEx Player console, click the Stop button.

To quit WebEx Player:
On the WebEx Player console, on the File menu, choose Exit.
Navigating a recording

When playing a recording, you can fast forward or rewind the recording. If segments were defined in the recording, you can navigate to a specific segment.

To fast forward playback:

Do either of the following:

- To browse a recording while fast forwarding it, click the Forward button. Each click moves the recording forward incrementally.
- To fast forward a recording to a specific location, drag the playback slider to the right.

To rewind a recording:

Do either of the following:

- To browse a recording while rewinding it, click the Rewind button. Each click moves the recording backward incrementally.
Chapter 11: Using WebEx Player

- To rewind a recording to a specific location, drag the playback slider to the left.

To navigate to the next or previous segment:
Click the Previous Segment button or Next Segment button, as appropriate.

Note: If no segments were defined in the recording, the Previous Segment and Next Segment buttons are unavailable.

To navigate to a specific segment:
1. On the Controls menu, point to Segment.
2. Choose Go to.

If segments were defined in the recording, they appear in the list.
3. In the list, select a segment.
4. Click OK.
Controlling full-screen view of playback

During playback, you can switch your view of a recording between a standard window and a full-screen view. A full-screen view of a recording fits your entire screen and does not include a title bar or scroll bars. You can also set WebEx Player to display all recordings in a full-screen view by default.

To display a recording in a full-screen view:
Click the Full Screen button.

To display a recording in a standard window:
Click the Full Screen button again.

To display all recordings in a full-screen view by default:
1. If you have not done so already, open a recording file (.wrf).
2. On the WebEx Player console, on the Controls menu, choose Settings.
   The Playback Settings dialog box appears.
Chapter 11: Using WebEx Player

3 Under Full Screen Setting, select the Play back in full screen mode by default check box.

4 Click OK.

Adjusting audio during playback

During playback of a recording, you can increase or decrease the audio volume, or mute or unmute audio.

To adjust playback volume:

Drag the Volume slider to the right or left to increase or decrease volume, respectively.

To mute audio:

Click the Mute button.
To unmute audio:

Click the Unmute button.

---

**Hiding or showing the player console**

Normally, the WebEx Player console appears on your screen when you are playing a recorded meeting. However, you can hide the WebEx Player console during playback. If the WebEx Player console is hidden, you can pause or stop playback by pressing a preset *hot key*—that is, a key on your computer’s keyboard.

**To hide the Player console during playback:**

1. If you have not done so already, open a recording file (.wrf).
2. On the WebEx Player console, on the Controls menu, choose Settings.
   The Playback Settings dialog box appears.
3 Under Player console settings, select the Hide Player console during playback check box.

4 Click OK.

While the WebEx Player console is hidden, you can:

- Pause and resume playback by pressing the Ctrl+Alt+P key combination on your keyboard
- Stop playback by pressing the Ctrl+Alt+S key combination on your keyboard

To make the WebEx Player console appear after it is hidden:

1 During playback, pause or stop playback by pressing the Ctrl+Alt+P or Ctrl+Alt+S key combination on your keyboard, respectively.

2 Optional. To keep the WebEx Player console visible, do the following:
   a) On the WebEx Player console, on the Controls menu, choose Settings.
   b) Under Player Console Settings, clear the Hide the Player Console during playback check box.
   c) Click OK.
For information about troubleshooting audio problems, see Problems with audio (on page 55).

For information about troubleshooting video problems, see Problems with video (on page 56).

**Problems with audio**

**Cannot hear audio.**

<table>
<thead>
<tr>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Audio was not captured in the recording.</td>
<td>See Recording audio with standalone recorders (on page 29).</td>
</tr>
<tr>
<td>Your computer does not meet the requirements for playing audio.</td>
<td>See System requirements for recording audio (on page 29).</td>
</tr>
</tbody>
</table>

**Audio sounds "tinny" or unclear.**

<table>
<thead>
<tr>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The quality of audio in a recording depends on the equipment with which it was captured during recording, including the computer’s sound card and microphone; and the equipment with you are playing it, including your computer’s sound card and speakers.</td>
<td>If you think your computer’s equipment is affecting audio quality during playback, try upgrading your computer’s sound card or speakers.</td>
</tr>
</tbody>
</table>
Chapter 12: Troubleshooting playback

Audio volume is too low.

<table>
<thead>
<tr>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The playback volume is set too low.</td>
<td>Adjust the playback volume on the WebEx Player console. See <em>Adjusting audio during playback</em> (on page 51).</td>
</tr>
<tr>
<td>The distance at which the person spoke into the microphone during recording was too far.</td>
<td>If you made the recording, try speaking into the microphone at various distances to determine the right distance for you.</td>
</tr>
<tr>
<td>The microphone input volume was set too low during recording.</td>
<td>If you made the recording, adjust the recording input volume before recording again. For details, see Setting up your sound card for recording audio.</td>
</tr>
</tbody>
</table>

Problems with video

Video appears blurry or blotchy.

<table>
<thead>
<tr>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>WebEx Player displays video at the color depth set for your computer's monitor. If a recording was made on a monitor with a higher color depth setting, video images may appear blurry or blotchy.</td>
<td>Increase your monitor's color depth to 16-bit (65,000 colors) or 24-bit (over 6 million colors). For instructions on setting color depth, see Windows Help.</td>
</tr>
</tbody>
</table>

Video images do not appear completely or are "cut off" on your screen.

<table>
<thead>
<tr>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Video was recorded on a computer with a monitor that was set to a higher screen resolution than that set on your computer's monitor.</td>
<td>Try setting your monitor's screen resolution to a higher setting—for example, 1024 by 768 pixels. For instructions on setting screen resolution, see Windows Help.</td>
</tr>
</tbody>
</table>
Uninstalling WebEx Recorder and Player

You can remove the standalone version of WebEx Recorder and WebEx Player from your computer, using your computer’s Add/Remove Programs utility. Uninstalling the software does not remove any recordings that reside on your computer.

To uninstall WebEx Recorder and Player:

1. Open the Windows Add/Remove Programs utility on your computer.
2. In the list of programs, select WebEx Recorder and Player.
3. Click Remove.
Index

A
annotation mode • 23
annotations • 23
changing color • 23
exiting • 23
making • 23
audio recording • 29, 30
input devices for teleconference • 30
system requirements • 30

C
changing annotation color • 23

E
exiting • 15, 23
annotation mode • 23
WebEx Recorder • 15

H
hiding the Recorder Panel • 19

I
inserting markers • 25

M
markers, inserting • 25
multiple applications, recording • 18

N
Network Recording Player • 7
Network-Based Recorder • 7

P
pausing recording • 11, 15
Player • 7, 8

R
Recorder • 7, 8, 15
exiting • 15
standalone • 8
starting • 15
Recorder Panel • 19
hiding • 19
showing • 19
recording • 11, 15, 18, 29
audio • 29
multiple applications • 18
on current computer • 11
pausing • 11, 15
resuming • 11, 15
starting • 11, 15
stopping • 11, 15
Recording Panel, inserting markers into a recording • 25
resuming recording • 11, 15

S

showing the Recorder Panel • 19
starting recording • 11, 15
stopping annotation • 23
stopping recording • 11, 15
system requirements • 8, 30
   audio recording • 30
   teleconference • 30

T

teleconference, system requirements • 30